# Contents

1 **Introduction to Plan**

1.1 Introduction ................................................. 8

1.1.1 ..................................................................... 8

1.2 Definitions ...................................................... 9

1.2.1 ..................................................................... 9

1.2.1.1 Introduction ........................................... 9

1.2.1.2 Terms .................................................... 9

1.3 Context Help ..................................................... 11

1.3.1 ..................................................................... 11

1.4 Main Work Space ............................................. 11

1.4.1 ..................................................................... 11

1.4.1.1 Description ............................................ 11

1.4.1.2 The View Selector ................................... 11

1.4.1.3 Schedule Selector .................................... 12

1.4.1.4 Status Bar ............................................ 12

1.5 Using the Views ................................................. 12

1.5.1 ..................................................................... 12

1.5.1.1 Description ............................................ 12

1.5.1.2 Navigation ............................................. 12

1.5.1.3 Editing data .......................................... 13

1.5.1.4 Drag & drop and copy/paste ...................... 13

2 **Guidelines**

2.1 Creating a Project ........................................... 14

2.1.1 ..................................................................... 14

2.2 Managing Resources ....................................... 14

2.2.1 Description .............................................. 14

2.3 Creating ODT Report Templates ..................... 15

2.3.1 ..................................................................... 15

2.3.1.1 Description .......................................... 15

2.3.1.2 User Field Variables ............................. 15

2.3.1.2.1 Variables ........................................ 15

2.3.1.2.1.1 Single Data Field ......................... 15
The Plan Handbook

2.3.1.2.1 Table Data ........................................ 15
2.3.1.2.1.3 Chart Data .................................... 16
2.3.1.2.2 Translated Labels ................................. 16
2.3.1.2.3 Project Values .................................... 16
2.3.1.2.4 Schedule Values .................................. 17
2.3.1.2.5 Tables ............................................... 17
2.3.1.3 Chart .................................................. 20
3 Views and Editors ........................................... 21
3.1 Startup View ............................................... 21
3.2 Task Editor ................................................ 21
3.3 Resource Editor .......................................... 25
3.4 Work and Vacation Editor ............................... 27
3.5 Cost Breakdown Structure Editor ..................... 28
3.6 Task Dependency Editor (Graphical) ................ 29
3.7 Task Dependency Editor (List) ......................... 31
3.1.1 .......................................................... 21
3.1.2 .......................................................... 21
3.1.3 .......................................................... 21
3.2.1 .......................................................... 21
3.2.1.1 Description .......................................... 21
3.2.1.2 Toolbar .............................................. 22
3.2.1.3 Editing data ......................................... 23
3.2.1.4 Task Modules Docker ............................. 24
3.2.1.5 Resources Docker ................................. 24
3.2.1.6 Allocations Docker ................................. 24
3.2.1.7 Configuration ....................................... 24
3.2.1 .......................................................... 21
3.3.1 .......................................................... 25
3.3.1.1 Description .......................................... 25
3.3.1.2 Toolbar .............................................. 25
3.3.1.3 Editing data ......................................... 26
3.3.1.4 Configuration ....................................... 26
3.3.1 .......................................................... 25
3.4.1 .......................................................... 27
3.4.1.1 Description .......................................... 27
3.4.1.2 Editing data ......................................... 28
3.4.1 .......................................................... 27
3.5.1 .......................................................... 28
3.5.1.1 Description .......................................... 28
3.5.1.2 Toolbar .............................................. 29
3.5.1.3 Editing data ......................................... 29
3.5.1 .......................................................... 28
3.6.1 .......................................................... 29
3.6.1.1 Description .......................................... 29
3.6.1.2 Editing dependencies ............................. 30
3.6.1.3 Toolbar .............................................. 30
3.6.1 .......................................................... 29
3.7.1 .......................................................... 31
3.8 Schedules Editor ................................................. 31
  3.8.1 ............................................................... 31
    3.8.1.1 Description ............................................. 31
    3.8.1.2 Toolbar .................................................. 32
    3.8.1.3 Editing data .............................................. 33
    3.8.1.4 Configuration ............................................ 34

3.9 Project Performance View .................................... 35
  3.9.1 Description .................................................. 35

3.10 Task Performance View ...................................... 35
  3.10.1 ............................................................... 35

3.11 Task Status View ............................................ 36
  3.11.1 ............................................................... 36
    3.11.1.1 Description ............................................. 36
    3.11.1.2 Editing data .............................................. 37
    3.11.1.3 Configuration ............................................ 37

3.12 Task Execution View ......................................... 38
  3.12.1 ............................................................... 38
    3.12.1.1 Description ............................................. 38
    3.12.1.2 Data ..................................................... 38
    3.12.1.3 Configuration ............................................ 39

3.13 Task Gantt View .............................................. 39
  3.13.1 ............................................................... 39
    3.13.1.1 Description ............................................. 39
    3.13.1.2 Editing data .............................................. 39
    3.13.1.3 Configuration ............................................ 40

3.14 Milestone Gantt View ...................................... 40
  3.14.1 ............................................................... 40
    3.14.1.1 Description ............................................. 40
    3.14.1.2 Editing data .............................................. 40
    3.14.1.3 Configuration ............................................ 40

3.15 Resource Assignment Gantt View .......................... 41
  3.15.1 ............................................................... 41
    3.15.1.1 Description ............................................. 41
    3.15.1.2 Data ..................................................... 41
    3.15.1.3 Editing data .............................................. 41
    3.15.1.4 Configuration ............................................ 41

3.16 Resource Assignment View ................................ 41
  3.16.1 ............................................................... 41
    3.16.1.1 Description ............................................. 41
    3.16.1.2 Data ..................................................... 42
    3.16.1.3 Editing data .............................................. 42
    3.16.1.4 Configuration ............................................ 42
4 Reports

4.1 Reports Generator View

4.1.1 Description

4.1.1.1 Description

4.1.1.2 Toolbar

5 Credits and License
Abstract
Chapter 1

Introduction to Plan

1.1 Introduction

1.1.1 Features include:

- Task management using the Task Editor
  - Work breakdown structure with configurable WBS codes
  - Tasks, summary tasks, and milestones
  - Different types of time constraints
  - Different types of dependencies.
- Resource management using the Resource Editor
  - Resource breakdown structure
  - Working- and material resource types
  - Resource allocation on group level
  - Resource teams
- Work time & vacation definition using the Work and Vacation Editor
- Cost management using the Cost Breakdown Structure Editor
- Earned value management
- Project scheduling using the Schedules Editor
  - Schedule forward from start time or backward from finish time
  - Allow or avoid resource overbooking
  - PERT distribution with optimistic-, pessimistic-, and most likely estimates
  - Multiple schedules with a possibility to schedule from current progress information
- Task tracking using the Task Execution View or Task Status View
1.2 Definitions

1.2.1

1.2.1.1 Introduction

In project management, terms may be used in different ways in different programs or different companies or project types. Looking at more exhaustive project management glossaries, one will find alternative definitions for most terms. This list defines how certain terms are used in Plan.

1.2.1.2 Terms

Account
An account is used in a Cost Breakdown Structure (CBS) to represent a place where cost from tasks or resources can be aggregated.

ACWP
Actual Cost of Work Performed

Actual Cost of Work Performed
The actual cost (or effort) that has been performed.

Allocation
Tasks are allocated to Resources during the planning stage of the project. The actual assignment is done during scheduling. Note that assignment is not guaranteed as the resource may not be available.

Assignment
Tasks are assigned to Resources during scheduling.

BCWS
Budgeted Cost of Work Scheduled

Budgeted Cost of Work Scheduled
The cost (or effort) that should have been used in order to reach the stated progress.

BCWP
Budgeted Cost of Work Performed

Budgeted Cost of Work Performed
The cost (or effort) that has been performed.

CBS
Cost Breakdown Structure

CPI
Is the Cost Performance Index and is equal to BCWP/ACWP. When this index is below 1, means that you are over budget. If the index is greater than 1 means that the costs are under budget.

Cost Breakdown structure
The CBS organizes accounts into a structure to enable cost to be aggregated independent of the WBS and RBS.
Estimate
The estimate is the expected amount of effort or time needed to complete a task.

Milestone
A milestone is a task with an effort of 0.00h. It is typically used to mark a major outcome, for example the completion of a deliverable upon customer acceptance.

PERT
Program Evaluation and Review Technique
The Program Evaluation and Review Technique is an enhancement to the Critical Path Method. Task effort estimates in CPM are point estimates, while task effort estimates in PERT are computed by weighting the Optimistic, Most Likely, and Pessimistic estimates \((O+(4*M)+P)/6\).

PERT Distribution
A simplified way to calculate Expected estimate from Optimistic-, Most Likely- and Pessimistic estimate.

RBS
Resource Breakdown Structure

Resource Breakdown Structure
The RBS organizes resources into resource groups.

Resource
A resource can be of type Work, Material or Team. A resource must always belong to a Resource Group.

Resource Group
A resource group is used to group similar resources.

Resource Team
A resource team is a resource that consists of a number of other resources.

SPI
Is the Schedule Performance Index and is equal to BCWP/BCWS. When this index is below 1, means that you are behind schedule. If the index is greater than 1 means that you are ahead of the schedule.

Summary Task
A Summary Task has subordinate Sub-Tasks, and rolls up information based on the Sub-Tasks.

Task
A Task is a unit of work. Resources are generally allocated at the Task level.

vCard
vCard is a file format standard for electronic business cards.

WBS
Work Breakdown Structure

Work Breakdown Structure
The WBS is used to break down large projects into manageable chunks to ease planning and management.
1.3 Context Help

1.3.1

Many functions and views have help and hints that can be displayed with the *What’s This* function.
You can activate it with the menu entry **Help → WhatsThis** or keyboard shortcut **Shift-F1**.
In dialogs it is activated by pressing the ? in the dialogs title bar.

1.4 Main Work Space

1.4.1

1.4.1.1 Description

The Main Work Space is normally organized with the View Selector to the left and the data view to the right.
As usual, you will also find the Menu bar and Toolbar at the top, and the Status bar at the bottom.
Since both the View selector and the Scripts docker are dockers they can be moved to the different border, floated or hidden. To show a hidden docker, use the **Settings → Dockers** menu entry.

1.4.1.2 The View Selector

The **View Selector** enables you to select the data view you want to display from the currently listed views.
Views are grouped into categories for easier retrieval: Editors, Views, Execution and Reports by default:

- Editors holds the editors that you need to define and schedule your project.
- Views holds views that are used for inspecting your project.
- Execution holds views that are especially useful during the execution of your project.
- Reports holds views for report generation.

Views can also be moved within or across categories, or added to or removed from the **View Selector**.
1.4.1.3 Schedule Selector

The Schedule Selector enables you to select the schedule all the views (e.g. Gantt View) shall display values from. Tasks which has not been scheduled in the selected schedule are not normally shown in any of the views. (They are shown in editors, of course.)

1.4.1.4 Status Bar

The status bar shows messages and progress information. Most notably is the currently selected schedule shown at the right of the status bar. Note that most of the views in the Views category display information depending on the selected schedule, so if the project is not scheduled (Not Scheduled), most views will be empty.

1.5 Using the Views

1.5.1

1.5.1.1 Description

The Task Editor is a view that displays task data in a tree structure. Most data in the Task Editor can be edited in situ.

1.5.1.2 Navigation

You can navigate the tree structure using the keyboard:

<table>
<thead>
<tr>
<th>Key</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>+</td>
<td>Expand an expandable row.</td>
</tr>
<tr>
<td>-</td>
<td>Collapse a collapsible item.</td>
</tr>
<tr>
<td>Arrow left</td>
<td>Go to previous column in the same row.</td>
</tr>
<tr>
<td>Arrow right</td>
<td>Go to next column in the same row.</td>
</tr>
<tr>
<td>Arrow up</td>
<td>Go to previous row in the same column.</td>
</tr>
</tbody>
</table>
1.5.1.3 Editing data

Editable items are opened for editing by double-clicking on the item or, if using the keyboard, pressing F2 will open the current item.

When editing an item you can navigate to the next editable item as follows:

| Ctrl-Alt-Arrow left | Go to the previous editable item in the same row. |
| Ctrl-Alt-Arrow right | Go to the next editable item in the same row. |
| Ctrl-Alt-Arrow up | Go to the next editable item in preceding rows. |
| Ctrl-Alt-Arrow down | Go to the next editable item in succeeding rows. |

1.5.1.4 Drag & drop and copy/paste

Most views support drag & drop and copy/paste. Charts and Gantt charts can be dragged to applications that support images. Table data uses the html mime type, so can be dropped on any applications that supports this. If the view supports moving or copying items internally e.g. the Task Editor, items can also be moved or copied.
Chapter 2

Guidelines

2.1 Creating a Project

2.1.1

A new project can be created by pressing the New Project button or selecting a project template in the Startup View.

This will create a new project with default values defined in Settings or from values defined in the template. The Project Settings Dialog will open to enable you to define project specific properties like project name, manager and target times.

When you create your first project, consider creating resources in a separate file. When you refer to this file in your project(s), you do not need to define your resources again, and you can coordinate resource usage across projects.

See Managing Resources.

If you want to coordinate resource usage across projects, your project files must be stored in the same directory.

A useful structure could be something like this:

```
Plan
   !-- Resources
   !   !-- SharedResources.plan
   !-- Taskmodules
   !   !-- Task modules (if any)
   !-- Templates
   !   !-- Project templates (if any)
   !-- Projects
   !   !-- <project 1>.plan
   !   !-- <project 2>.plan
   !   !-- etc
```

2.2 Managing Resources

2.2.1 Description

You can create resources for a project using the Resource Editor and Work and Vacation Editor.
However, if you are going to use the same resources in many projects (which is often the case) it is more convenient to maintain resources in a separate file. The best way to do this is to create your resources file first and then set up Plan to always load this file when creating a new project. If you are managing projects that use totally different resource pools you can create multiple resource files, but one project can only refer to one resource file.
You can select the resource file to use when creating a new project.

2.3 Creating ODT Report Templates

2.3.1

2.3.1.1 Description

Open Document Text report templates are regular ODT files that can be designed using any ODT word processor like Calligra Words or LibreOffice Writer. The technique used is to use *user field* variables to hold references to the information that shall be fetched from the project. The variables are called *User Fields* in *Writer* and can be found under **Insert** → **Field** → **More Fields** → **Variables** → **User Fields**. In *Words* they are called *Custom Variables* and can be found under **Text Editing docker** → **Variable** → **Custom**.

The easiest way to create a new report template is to modify an existing one as all user fields are defined.

2.3.1.2 User Field Variables

2.3.1.2.1 Variables

The variables are used to enable the generator to extract data from the project.
A variable can be a reference to a single data field, a reference to table data or a reference to chart data.

2.3.1.2.1.1 Single Data Field

A single data field variable has the following format:

```
data group name.property = property identifier
```

where:

- `data group name` can be `tr`, `project` or `schedule` (see below).
- `property` makes the user field name unique.
- `property identifier` identifies the property in the data group.

2.3.1.2.1.2 Table Data

A table in a report template consists of a variable to specify the data table to use.
The variable name must start with `table` (e.g. `tableTasks`) and the variable value must be the name of the data table (e.g. `tasks`).

Immediately after the variable, a table must be inserted and columns filled with user field variables that specify which properties to fetch from the table specified above. These variables must have names that start with the name of the table variable above.
These variables have the following format:

```
tableTasks.property = property identifier
```

where:

- **property** makes the user field name unique.
- **property identifier** identifies the property in the data group.

### 2.3.1.2.3 Chart Data

A chart in a report template consists of a variable to specify the data to use in the chart. The variable name must start with `chart` (e.g. `chartBudgetCost`) and the variable value specifies the data group and values to populate the chart.

The variable has the following format (note the semicolons):

```
name = data group; values=comma separated list of data properties;
```

where:

- **name** must start with `chart` (e.g. `chartBudgetCost`)
- **data group**
- **comma separated list of data properties** identifies the properties in the data group.

E.g.:

```
chartBudget = project; values=bcws cost, bcwp cost, acwp cost;
```

### 2.3.1.2.2 Translated Labels

Translated labels enable us to produce general report templates that can be used in different languages.

<table>
<thead>
<tr>
<th>Variable Name</th>
<th>Variable Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>tr.project</td>
<td>Project</td>
</tr>
<tr>
<td>tr.manager</td>
<td>Manager</td>
</tr>
<tr>
<td>tr.schedule</td>
<td>Schedule</td>
</tr>
<tr>
<td>tr.bcws</td>
<td>BCWS</td>
</tr>
<tr>
<td>tr.bcwp</td>
<td>BCWP</td>
</tr>
<tr>
<td>tr.acwp</td>
<td>ACWP</td>
</tr>
<tr>
<td>tr.spi</td>
<td>SPI</td>
</tr>
<tr>
<td>tr.cpi</td>
<td>CPI</td>
</tr>
</tbody>
</table>

### 2.3.1.2.3 Project Values

Shows values from the main project.

<table>
<thead>
<tr>
<th>Variable Name</th>
<th>Variable Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>project.name</td>
<td>Name</td>
<td>The name of the project</td>
</tr>
</tbody>
</table>
### The Plan Handbook

<table>
<thead>
<tr>
<th>Variable Name</th>
<th>Variable Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>project.manager</td>
<td>Manager</td>
<td>The name of the project manager</td>
</tr>
<tr>
<td>project.bcwscost</td>
<td>BCWS Cost</td>
<td>Cost based Budgeted Cost of Work Scheduled</td>
</tr>
<tr>
<td>project.bcwpcost</td>
<td>BCWP Cost</td>
<td>Cost based Budgeted Cost of Work Performed</td>
</tr>
<tr>
<td>project.acwpcost</td>
<td>ACWP Cost</td>
<td>Cost based Actual Cost of Work Performed</td>
</tr>
<tr>
<td>project.spicost</td>
<td>SPI Cost</td>
<td>Cost based Schedule Performance Index</td>
</tr>
<tr>
<td>project.cpicost</td>
<td>CPI Cost</td>
<td>Cost based Cost Performance Index</td>
</tr>
<tr>
<td>project.bcwseffort</td>
<td>BCWS Effort</td>
<td>Effort based Budgeted Cost of Work Scheduled</td>
</tr>
<tr>
<td>project.bcwpeffort</td>
<td>BCWP Effort</td>
<td>Effort based Budgeted Cost of Work Performed</td>
</tr>
<tr>
<td>project.acwpeffort</td>
<td>ACWP Effort</td>
<td>Effort based Actual Cost of Work Performed</td>
</tr>
<tr>
<td>project.spieffort</td>
<td>SPI Effort</td>
<td>Effort based Schedule Performance Index</td>
</tr>
<tr>
<td>project.cpieffort</td>
<td>CPI Effort</td>
<td>Effort based Cost Performance Index</td>
</tr>
</tbody>
</table>

#### 2.3.1.2.4 Schedule Values

Shows values from the current schedule.

<table>
<thead>
<tr>
<th>Variable Name</th>
<th>Variable Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>schedule.name</td>
<td>Name</td>
<td>The name of the schedule</td>
</tr>
<tr>
<td>schedule.state</td>
<td>State</td>
<td>Scheduling state</td>
</tr>
<tr>
<td>schedule.direction</td>
<td>Name</td>
<td>Scheduling direction</td>
</tr>
<tr>
<td>schedule.overbooking</td>
<td>Overbooking</td>
<td>Overbooking</td>
</tr>
<tr>
<td>schedule.distribution</td>
<td>Distribution</td>
<td>Distribution</td>
</tr>
<tr>
<td>schedule.plannedstart</td>
<td>Planned Start</td>
<td>Planned Start</td>
</tr>
<tr>
<td>schedule.plannedfinish</td>
<td>Planned Finish</td>
<td>Planned Finish</td>
</tr>
<tr>
<td>schedule.scheduler</td>
<td>Scheduler</td>
<td>Scheduler</td>
</tr>
<tr>
<td>schedule.granularity</td>
<td>Granularity</td>
<td>Granularity</td>
</tr>
<tr>
<td>schedule.mode</td>
<td>Mode</td>
<td>Scheduling mode (Auto or Manual)</td>
</tr>
</tbody>
</table>

#### 2.3.1.2.5 Tables

Supported table types:

- tasks
- taskstatus
- schedules
- projects
To create a table, place a variable just before a table in your template file. The variable name identifies the table and must start with `table`, e.g. `tableTaskStatus`.

The value of the variable is used to point to the data to be fetched and must be one of the supported tables listed above, e.g. `taskstatus`.

You then put variables inside the table cells with name and value from the table below.

Note that the schedules table supports the values described in Schedule Values above.

The projects, tasks and taskstatus tables supports the following values:

<table>
<thead>
<tr>
<th>Variable Name</th>
<th>Variable Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>table name.name</code></td>
<td>Name</td>
<td>The name of the task or project</td>
</tr>
<tr>
<td><code>table name.wbscode</code></td>
<td>WBS Code</td>
<td></td>
</tr>
<tr>
<td><code>table name.type</code></td>
<td>Type</td>
<td>Type of task</td>
</tr>
<tr>
<td><code>table name.responsible</code></td>
<td>Responsible</td>
<td></td>
</tr>
<tr>
<td><code>table name.allocation</code></td>
<td>Allocation</td>
<td></td>
</tr>
<tr>
<td><code>table name.estimate</code></td>
<td>Estimate</td>
<td>Most likely estimate</td>
</tr>
<tr>
<td><code>table name.optimistic</code></td>
<td>Optimistic</td>
<td>Optimistic ratio</td>
</tr>
<tr>
<td><code>table name.pessimistic</code></td>
<td>Pessimistic</td>
<td>Pessimistic ratio</td>
</tr>
<tr>
<td><code>table name.risk</code></td>
<td>Risk</td>
<td>Estimate uncertainty</td>
</tr>
<tr>
<td><code>table name.constraint</code></td>
<td>Constraint</td>
<td>Type of time constraint</td>
</tr>
<tr>
<td><code>table name.constraintstart</code></td>
<td>Constraint Start</td>
<td>Constraint start time</td>
</tr>
<tr>
<td><code>table name.constraintend</code></td>
<td>Constraint End</td>
<td>Constraint finish time</td>
</tr>
<tr>
<td><code>table name.runningaccount</code></td>
<td>Running Account</td>
<td>Account for running costs</td>
</tr>
<tr>
<td><code>table name.startupaccount</code></td>
<td>Startup Account</td>
<td>Account for startup cost</td>
</tr>
<tr>
<td><code>table name.startupcost</code></td>
<td>Startup Cost</td>
<td>The cost incurred at startup of the task</td>
</tr>
<tr>
<td><code>table name.shutdownaccount</code></td>
<td>Shutdown Account</td>
<td>Account for shutdown cost</td>
</tr>
<tr>
<td><code>table name.shutdowncost</code></td>
<td>Shutdown Cost</td>
<td>The cost incurred at shutdown of the task</td>
</tr>
<tr>
<td><code>table name.description</code></td>
<td>Description</td>
<td>Task description</td>
</tr>
<tr>
<td><code>table name.expected</code></td>
<td>Expected</td>
<td>Calculated most likely estimate</td>
</tr>
<tr>
<td><code>table name.optimistic</code></td>
<td>Optimistic</td>
<td>Calculated optimistic estimate</td>
</tr>
<tr>
<td><code>table name.pessimistic</code></td>
<td>Pessimistic</td>
<td>Calculated pessimistic estimate</td>
</tr>
<tr>
<td><code>table name.starttime</code></td>
<td>Start Time</td>
<td>Scheduled start time</td>
</tr>
<tr>
<td><code>table name.endtime</code></td>
<td>End Time</td>
<td>Scheduled finish time</td>
</tr>
<tr>
<td><code>table name.duration</code></td>
<td>Duration</td>
<td>Scheduled duration</td>
</tr>
<tr>
<td><code>table name.earliestart</code></td>
<td>Early Start</td>
<td>Earliest possible start</td>
</tr>
<tr>
<td><code>table name.earliestfinish</code></td>
<td>Early Finish</td>
<td>Earliest possible finish</td>
</tr>
<tr>
<td><code>table name.latestart</code></td>
<td>Late Start</td>
<td>Latest possible start</td>
</tr>
<tr>
<td><code>table name.latefinish</code></td>
<td>Late Finish</td>
<td>Latest possible finish</td>
</tr>
<tr>
<td>Table Name</td>
<td>Description</td>
<td></td>
</tr>
<tr>
<td>-----------------------------</td>
<td>--------------------------------------------------</td>
<td></td>
</tr>
<tr>
<td><code>positivefloat</code></td>
<td>Positive Float</td>
<td></td>
</tr>
<tr>
<td><code>freefloat</code></td>
<td>Free Float</td>
<td></td>
</tr>
<tr>
<td><code>negativefloat</code></td>
<td>Negative Float</td>
<td></td>
</tr>
<tr>
<td><code>startfloat</code></td>
<td>Start Float</td>
<td></td>
</tr>
<tr>
<td><code>finishfloat</code></td>
<td>Finish Float</td>
<td></td>
</tr>
<tr>
<td><code>assignaments</code></td>
<td>Assignments</td>
<td></td>
</tr>
<tr>
<td><code>varianceest</code></td>
<td>Calculated estimate variance</td>
<td></td>
</tr>
<tr>
<td><code>variancedur</code></td>
<td>Calculated duration variance</td>
<td></td>
</tr>
<tr>
<td><code>optimisticdur</code></td>
<td>Calculated optimistic duration</td>
<td></td>
</tr>
<tr>
<td><code>pessimisticdur</code></td>
<td>Calculated pessimistic duration</td>
<td></td>
</tr>
<tr>
<td><code>status</code></td>
<td>Task status as shown in Task Status View</td>
<td></td>
</tr>
<tr>
<td><code>completion</code></td>
<td>% Completed</td>
<td></td>
</tr>
<tr>
<td><code>plannedeffort</code></td>
<td>Planned Effort</td>
<td></td>
</tr>
<tr>
<td><code>actualeffort</code></td>
<td>Actual Effort</td>
<td></td>
</tr>
<tr>
<td><code>remainingeffort</code></td>
<td>Remaining Effort</td>
<td></td>
</tr>
<tr>
<td><code>plannedcost</code></td>
<td>Planned Cost</td>
<td></td>
</tr>
<tr>
<td><code>actualcost</code></td>
<td>Actual Cost</td>
<td></td>
</tr>
<tr>
<td><code>plannedstart</code></td>
<td>Planned Start</td>
<td></td>
</tr>
<tr>
<td><code>actualstart</code></td>
<td>Actual Start</td>
<td></td>
</tr>
<tr>
<td><code>started</code></td>
<td>Started</td>
<td></td>
</tr>
<tr>
<td><code>actualfinish</code></td>
<td>Actual Finish</td>
<td></td>
</tr>
<tr>
<td><code>finished</code></td>
<td>Finished</td>
<td></td>
</tr>
<tr>
<td><code>schedulingstatus</code></td>
<td>Scheduling Status</td>
<td></td>
</tr>
<tr>
<td><code>bcws</code></td>
<td>Budgeted Cost of Work Scheduled (cost based)</td>
<td></td>
</tr>
<tr>
<td><code>bcwp</code></td>
<td>Budgeted Cost of Work Performed (cost based)</td>
<td></td>
</tr>
<tr>
<td><code>acwp</code></td>
<td>Actual Cost of Work Performed (cost based)</td>
<td></td>
</tr>
<tr>
<td><code>spi</code></td>
<td>Schedule Performance Index</td>
<td></td>
</tr>
<tr>
<td><code>critical</code></td>
<td>Task is critical</td>
<td></td>
</tr>
<tr>
<td><code>criticalpath</code></td>
<td>Task is in critical path</td>
<td></td>
</tr>
<tr>
<td><code>notscheduled</code></td>
<td>Not interesting</td>
<td></td>
</tr>
<tr>
<td><code>assignmentmissing</code></td>
<td>Assignment Missing</td>
<td></td>
</tr>
<tr>
<td><code>resourceoverbooked</code></td>
<td>Resource Overbooked</td>
<td></td>
</tr>
<tr>
<td><code>resourceunavailable</code></td>
<td>Resource Unavailable</td>
<td></td>
</tr>
<tr>
<td><code>constrainterror</code></td>
<td>Constraints Error</td>
<td></td>
</tr>
<tr>
<td><code>effortnotmet</code></td>
<td>Effort Not Met</td>
<td></td>
</tr>
</tbody>
</table>
table name.schedulingerror | Scheduling Error | Not interesting
---|---|---
**table name.level** | Node level, Level | Not interesting
**table name.statusnote** | Status Note | Note: Not implemented
**table name.owner** | Owner | Must not be used, and are not very interesting
**table name.status** | Status | Must not be used, and are not very interesting
**table name.time** | Time | Must not be used, and are not very interesting

### 2.3.1.3 Chart

Use by placing a variable with name chartX (X=some text to make the variable name unique) with a value project before the chart that shall be used.

The variable has this format:

Variable: Name: chartX (X=some text) Value: project; values=data;

where `data` is a comma separated list of values to be include in the chart.

Possible `data` values are:

- **bcws effort** Budgeted cost of work scheduled, effort based.
- **bcwp effort** Budgeted cost of work performed, effort based.
- **acwp effort** Actual cost of work performed, effort based.
- **spi effort** Schedule performance index, effort based.
- **cpi effort** Cost performance index, effort based.
- **bcws cost** Budgeted cost of work scheduled, cost based.
- **bcwp cost** Budgeted cost of work performed, cost based.
- **acwp cost** Actual cost of work performed, cost based.
- **spi cost** Schedule performance index, cost based.
- **cpi cost** Cost performance index, cost based.

The charts you create in your template must have the same (or more) number of columns as the number of values you specify in your variable.

Example:

Variable name: chart1 Value: project; values=bcws cost,bcwp cost, acwp cost;

Note that you cannot mix effort- and cost-based values. If you want to show both, create two charts.

### 2.3.1.3.1 Gantt

Not supported.
Chapter 3

Views and Editors

3.1  Startup View

3.1.1
The Startup View is shown at startup and when File → New is selected. It has 3 sections for:

• Creation of new projects. See also Creating a Project and Managing Resources
• Opening existing projects. This section gives you the possibility to open an existing project file or one of the 10 most recent projects you have opened.
• The Help section gives you links to introductory pages, documentation and community forum.

3.2  Task Editor

3.2.1

3.2.1.1 Description

The Task Editor is used to create, edit, and delete tasks. Tasks can be organized into a hierarchical tree structure to any depth.
3.2.1.2 Toolbar

The toolbar provides the means to create, delete and move tasks and milestones:

<table>
<thead>
<tr>
<th>Button</th>
<th>Shortcut</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add Task</td>
<td>Ctrl-I</td>
<td>Dropdown box to create a task or milestone. The new item is positioned after the currently selected item on the same level as the selected item. If no item is selected, the new item is appended at the top level.</td>
</tr>
<tr>
<td></td>
<td>Ctrl-Alt-I</td>
<td></td>
</tr>
<tr>
<td>Add Sub-task</td>
<td>Ctrl-Shift-I</td>
<td>Dropdown box to create a sub-task or milestone. The new item is appended as a child to the currently selected item.</td>
</tr>
<tr>
<td></td>
<td>Ctrl-Shift-Alt-I</td>
<td></td>
</tr>
<tr>
<td>Delete Task</td>
<td>Delete</td>
<td>Deletes the selected tasks.</td>
</tr>
<tr>
<td>Indent Task</td>
<td></td>
<td>Appends the selected task as a child to the task above.</td>
</tr>
<tr>
<td>Unindent Task</td>
<td></td>
<td>Moves the selected task one level up, inserting it after its current parent task.</td>
</tr>
<tr>
<td>Move Up</td>
<td></td>
<td>Moves the selected task up one place.</td>
</tr>
<tr>
<td>Move Down</td>
<td></td>
<td>Moves the selected task down one place.</td>
</tr>
</tbody>
</table>

Note that you can also move or copy tasks using drag and drop or copy/paste.
### 3.2.1.3 Editing data

Data can be edited inline as described here or by using the Task Settings Dialog.

The following columns are displayed as default:

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name of the task.</td>
</tr>
<tr>
<td>Status</td>
<td>Task status</td>
</tr>
<tr>
<td>Responsible</td>
<td>The person responsible for this task.</td>
</tr>
<tr>
<td>Allocation</td>
<td>List of resource allocations.</td>
</tr>
<tr>
<td>Type</td>
<td>The type of task or the estimate type of the task.</td>
</tr>
<tr>
<td></td>
<td>The type can be set to Milestone, Effort or Duration.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> If the type is Summary or Project the type is not editable.</td>
</tr>
<tr>
<td>Calendar</td>
<td>The calendar used when estimate type is Duration.</td>
</tr>
<tr>
<td>Estimate</td>
<td>The most likely estimate. The estimate is the expected amount of effort or time needed to complete a task. It can be expressed in different units: h (hours), d (days), w (weeks) and M (months).</td>
</tr>
<tr>
<td>Optimistic Ratio</td>
<td>Optimistic estimate expressed as a negative percentage of the most likely estimate. (E.g. -20%). This is only used if a PERT distribution is used.</td>
</tr>
<tr>
<td>Pessimistic Ratio</td>
<td>Pessimistic estimate expressed as a positive percentage of the most likely estimate. (E.g. 50%). This is only used if a PERT distribution is used.</td>
</tr>
<tr>
<td>Risk</td>
<td>Risk controls the PERT distribution used when calculating the actual estimate for this task.</td>
</tr>
<tr>
<td>Constraint</td>
<td>The timing constraint type.</td>
</tr>
<tr>
<td>Constraint Start</td>
<td>Constraint start time.</td>
</tr>
<tr>
<td>Constraint End</td>
<td>Constraint end time.</td>
</tr>
<tr>
<td>Running Account</td>
<td>Account for running costs.</td>
</tr>
<tr>
<td>Startup Account</td>
<td>Account for cost incurred at startup of the task.</td>
</tr>
<tr>
<td>Startup Cost</td>
<td>The cost incurred at startup of the task.</td>
</tr>
<tr>
<td>Shutdown Account</td>
<td>Account for cost incurred at shutdown of the task.</td>
</tr>
<tr>
<td>Shutdown Cost</td>
<td>The cost incurred at shutdown of the task.</td>
</tr>
<tr>
<td>Description</td>
<td>Task notes.</td>
</tr>
</tbody>
</table>

23
3.2.1.4 Task Modules Docker

Task Modules are groups of tasks that can be reused across projects. This makes it possible to draw on past experience and to standardize similar operations. A task module is inserted into your project by dragging it from the docker and dropping it into your project. A task module is a regular plan file, and is designed using Plan in the same way as designing a regular project. A task module, however, typically includes only tasks, estimates, and dependencies. The project name is displayed in the docker, and the description is used as the tooltip. A module can be opened for inspection or editing by double-clicking on the module. The modules can be grouped by storing them in different directories. Where to search for them is configured using the Project Settings Dialog. Default values for new projects can be defined using the Plan Configuration Dialog.

3.2.1.5 Resources Docker

The Resources Docker offers a simple way to allocate resources to tasks by selecting the resources you need and dragging them onto the Allocation column. A resource can also be dropped on the Responsible column.

3.2.1.6 Allocations Docker

The Allocations Docker displays the current resource allocation for the selected task.

3.2.1.7 Configuration

Using the context menu, the view can be configured to show / hide the Project, split / unsplit the tree view or it can be configured using the configure dialog.

The configure dialog enables you to tailor the amount of information the view displays to fit your needs.
3.3 Resource Editor

3.3.1 Description

The Resource Editor is used to create, edit, and delete resources and resource groups. Resources must belong to a resource group. At the moment sub-groups are not allowed.

Working resources must refer to a calendar that defines the working hours for the resource. Calendars are created using the Work and Vacation Editor.

Material resources are by default always available. You can use a calendar to limit its availability. Resources can be Shared or Local. A local resource is only used in the current project. A shared resource can be shared between multiple projects and is stored in a separate file, see Managing Resources.

3.3.1.2 Toolbar

The toolbar provides the means to create and delete resources and resource groups:

<table>
<thead>
<tr>
<th>Button</th>
<th>Shortcut</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add Resource Group</td>
<td>Ctrl-I</td>
<td>Button to create a resource group. The new group is appended at the end of the groups.</td>
</tr>
<tr>
<td>Add Resource</td>
<td>Ctrl-Shift-I</td>
<td>Button to create a resource. The new resource is appended as a child to the currently selected group. If a resource is selected, the new resource is appended to its parent group.</td>
</tr>
</tbody>
</table>
Delete

Deletes the selected resources and/or resource groups.

Resources can be created by dropping data from any application that supports dragging vCard information, like KAddressBook or Evolution.

Resources can be copied or moved to a different resource group using drag-and-drop.

**NOTE**
When moving a resource, the resource will lose any allocations.

### 3.3.1.3 Editing data

Data can be edited inline as described [here.](#)

Resources can also be edited using the Resource Settings Dialog.

The following columns are displayed as default:

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name of the resource or resource group.</td>
</tr>
<tr>
<td>Scope</td>
<td>A resource can be <em>Shared</em> or <em>Local</em>. A shared resource cannot be edited.</td>
</tr>
<tr>
<td>Type</td>
<td>The type of resource or resource group.</td>
</tr>
<tr>
<td>Initials</td>
<td>The initials of the resource.</td>
</tr>
<tr>
<td>Email</td>
<td>The e-mail address of the resource.</td>
</tr>
<tr>
<td>Calendar</td>
<td>The calendar defines when the resource is working.</td>
</tr>
<tr>
<td>Limit (%)</td>
<td>The maximum load that can be assigned.</td>
</tr>
<tr>
<td>Available From</td>
<td>Defines when the resource is available to the project.</td>
</tr>
<tr>
<td>Available Until</td>
<td>Defines when the resource is available to the project.</td>
</tr>
<tr>
<td>Normal Rate</td>
<td>The cost per hour, normal hours.</td>
</tr>
<tr>
<td>Account</td>
<td>The account where the resource cost is accumulated.</td>
</tr>
</tbody>
</table>

### 3.3.1.4 Configuration
Using the context menu, the view can be configured to split/unsplit the tree view or it can be configured using the configure dialog. The configure dialog enables you to tailor the amount of information the view displays to fit your needs.

3.4 Work and Vacation Editor

3.4.1 Description

The Work and Vacation Editor is used to create, edit, and delete calendars. Calendars define the working hours for resources. Calendars can also be used by tasks with estimate type Duration.

Calendars have a time zone specification so you can define working hours in the resources local time.

A calendar consists of definitions for weekdays and dates. If the date has a definition, this definition is used. If the state of the date is Undefined, the definition for the weekday is used. If this is also Undefined, the parent calendar is checked.

A calendar can be defined as Default and is then used by all working resources without a calendar reference.

The toolbar provides the means to create and delete calendars:
### 3.5 Cost Breakdown Structure Editor

#### 3.5.1 Description

The Cost Breakdown Structure Editor is used to create, edit, and delete accounts.

Accounts can be connected to by tasks and resources to accumulate costs from those tasks and resources.

The default account accumulates costs incurred from tasks that are not connected to an account.
3.5.1.2 Toolbar

The toolbar provides the means to create and delete accounts:

<table>
<thead>
<tr>
<th>Button</th>
<th>Shortcut</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add Account</td>
<td>Ctrl-I</td>
<td>Button to create an account. The new account is inserted after the selected account. If no account is selected, the new account is appended at the top level.</td>
</tr>
<tr>
<td>Add Subaccount</td>
<td>Ctrl-Shift-I</td>
<td>Button to create a sub-account. The new account is appended as a child to selected account.</td>
</tr>
<tr>
<td>Delete</td>
<td>Delete</td>
<td>Deletes the selected account.</td>
</tr>
</tbody>
</table>

3.5.1.3 Editing data

Data can be edited inline as described here.

The following columns are available:

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name of the account.</td>
</tr>
<tr>
<td>Description</td>
<td>The description of the account.</td>
</tr>
</tbody>
</table>

3.6 Task Dependency Editor (Graphical)

3.6.1

3.6.1.1 Description

The Task Dependency Editor is used to create, edit, and delete task dependencies. For convenience, tasks can also be inserted, deleted or edited.

The tasks are ordered in accordance with the Work Breakdown Structure (WBS).
The Plan Handbook

The symbols for summary tasks, tasks and milestones are shown below:

As the Task and Milestone are sub-items to the Summary task, they are indented. Also, note that the WBS code is displayed along with the name.

In the following figure, a Finish-Start dependency has been inserted to make Milestone depend on Task.

As shown below, an item consists of three different selection areas:

<table>
<thead>
<tr>
<th>Item area</th>
<th>Select the item for editing</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start area</td>
<td>Used for creating Finish-Start and Start-Start dependencies</td>
</tr>
<tr>
<td>Finish area</td>
<td>Used for creating Finish-Start and Finish-Finish dependencies</td>
</tr>
</tbody>
</table>

3.6.1.2 Editing dependencies

Dependencies are created by first selecting a start- or finish area of the predecessor task, then selecting the start- or finish area of the successor task.

This can be done using the mouse or the keyboard.

Alternatively, you can drop the predecessor’s connection area on the successor’s connection area.

To edit or delete an existing dependency, you can open a dependency by selecting it, or open its context menu.

You can also open the context menu on a connection area which will enable you to edit all dependencies connected to that area.

3.6.1.3 Toolbar

The toolbar provides the means to create and delete tasks:
### Button | Shortcut | Description
--- | --- | ---
Add Task | Ctrl-I | Dropdown box to create a task or milestone. The new item is positioned after the currently selected item on the same level as the selected item. If no item is selected, the new item is appended at the top level.
Ctrl-Alt-I
Add Sub-task | Ctrl-Shift-I | Dropdown box to create a sub-task or milestone. The new item is appended as a child to the currently selected item.
Ctrl-Shift-Alt-I
Delete Task | Delete | Deletes the selected tasks.

### 3.7 Task Dependency Editor (List)

#### 3.7.1

**NOTE**
This view is not shown by default. For large projects, it can impact performance severely

It can be activated using the View Selector context menu.

### 3.8 Schedules Editor

#### 3.8.1

#### 3.8.1.1 Description

The Schedule Editor is used to create, edit, calculate and delete schedules.
The Plan Handbook

The Schedule Editor has three sub-views that show the results of the scheduling. The Result sub-view shows the values needed for PERT analysis including early start and -finish, late start and -finish along with different types of float.

The Critical Path sub-view shows the tasks that belong to the critical path.

The Scheduling Log sub-view shows a list of messages produced during scheduling.

3.8.1.2 Toolbar

The toolbar provides the means to create, delete and calculate schedules:
### 3.8.1.3 Editing data

Data can be edited in-line as described [here](#).

The following columns are displayed as default:

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name of the schedule.</td>
</tr>
<tr>
<td>State</td>
<td>The schedules state. Shows a progress bar during scheduling.</td>
</tr>
<tr>
<td>Direction</td>
<td>The scheduling direction. If the direction is Forward, the project is scheduled starting at the project’s earliest start time specified in the main project dialog. If the direction is Backward, the project is scheduled starting at the project’s latest finish time specified in the main project dialog.</td>
</tr>
</tbody>
</table>
### The Plan Handbook

**Overbooking**

- **Controls resource overbooking when scheduling.**
  - If overbooking is allowed, a resource may be booked (on working days) to work more than it is available. This can happen if the resource is allocated to multiple tasks or are booked on other projects.
  - If overbooking is to be avoided, resources will not be booked more than they are available. On resource conflict, tasks will be delayed until the resource is available.

**Distribution**

- The distribution to be used during scheduling.
  - If the distribution is 'None', the estimate of the task is used as-is during scheduling.
  - If the distribution is 'PERT', the estimate (E) used is calculated based on the entered optimistic-(O), pessimistic-(P) and most likely (M) estimate. The formula used for this is:
  
  \[ E = \frac{O + 4 \times M + P}{6}. \]

**Planned Start**

- The scheduled start time.

**Planned Finish**

- The scheduled finish time.

**Scheduler**

- The scheduler used for calculating the project schedule.
  - The default built-in scheduler is the Network Scheduler.

3.8.1.4 Configuration

Using the context menu, the view can be configured to split/unsplit the tree view or it can be configured using the configure dialog.

The configure dialog enables you to tailor the amount of information the view displays to fit your needs.
3.9 Project Performance View

3.9.1 Description

The Project performance view is a project management chart where can be understood the actual situation of the project according to the Earned Value Method.

where:

- BCWS means Budgeted Cost Work Scheduled,
- BCWP means Budgeted Cost Work Performed,
- ACWP means Actual Cost Work Performed.

All these are considered as effort in hours and costs.

PI are the Performance Indexes, where:

- CPI is the Cost Performance Index,
- SPI is the Schedule Performance Index.

3.10 Task Performance View

3.10.1

On the task performance chart, we can analyze deeply each subtask or task with the same indexes as for the project performance view.

This is really useful in a long and complicated project.

On the left window, you can choose every single sub-task as well as an entire task, then on the right window will appear in the corresponding chart.
where:

- BCWS means Budgeted Cost Work Scheduled,
- BCWP means Budgeted Cost Work Performed,
- ACWP means Actual Cost Work Performed.

All these are considered as effort in hours and costs.

PI are the Performance Indexes, where:

- CPI is the Cost Performance Index,
- SPI is the Schedule Performance Index.

### 3.11 Task Status View

#### 3.11.1 Description

The Task Status View is used to inspect task progress information at a period, set in the configuration.

The tasks are divided into groups dependent on the status of the task:
The Plan Handbook

<table>
<thead>
<tr>
<th>Not Started</th>
<th>Tasks that should have been started by now.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Running</td>
<td>Tasks that have been started, but not yet finished.</td>
</tr>
<tr>
<td>Finished</td>
<td>Tasks that were finished in this period</td>
</tr>
<tr>
<td>Next Period</td>
<td>Tasks that are scheduled to be started in the next period.</td>
</tr>
</tbody>
</table>

3.11.1.2 Editing data

Progress information can be edited in-line as described here or by using the task progress dialog.

The following columns are displayed as default:

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name of the task.</td>
</tr>
<tr>
<td>Status</td>
<td>Task status</td>
</tr>
<tr>
<td>% Completion</td>
<td>Task completion</td>
</tr>
<tr>
<td>Planned Effort</td>
<td>The amount of work planned to be used at the end of the current period.</td>
</tr>
<tr>
<td>Actual Effort</td>
<td>The amount of work spent.</td>
</tr>
<tr>
<td>Remaining Effort</td>
<td>The remaining effort needed to complete the task.</td>
</tr>
<tr>
<td>Planned Cost</td>
<td>The planned cost at the end of the current period.</td>
</tr>
<tr>
<td>Actual Cost</td>
<td>The actual cost incurred.</td>
</tr>
<tr>
<td>Actual Start</td>
<td>The actual start time of the task.</td>
</tr>
<tr>
<td>Actual Finish</td>
<td>The actual finish time of the task.</td>
</tr>
</tbody>
</table>

3.11.1.3 Configuration

Using the context menu, the view can be configured to split / unsplit the tree view or it can be configured using the configure dialog.
The configure dialog enables you to tailor the amount of information the view displays to fit your needs.

### 3.12 Task Execution View

#### 3.12.1 Description

The Task Execution View is used to inspect task performance information.

#### 3.12.1.2 Data

Progress information can be edited in-line as described here or by using the task progress dialog.

The following columns are displayed as default:

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name of the task.</td>
</tr>
</tbody>
</table>
### 3.12.1.3 Configuration

Using the context menu, the view can be configured to show / hide the Project, split / unsplit the tree view or it can be configured using the configure dialog.

The configure dialog enables you to tailor the amount of information the view displays to fit your needs.

### 3.13 Task Gantt View

#### 3.13.1

#### 3.13.1.1 Description

The Gantt view is used to show tasks in a timeline.

\[ \text{Gantt View} \]

#### 3.13.1.2 Editing data

Task description and progress can be edited using the context menu.

The following columns are displayed as default:

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name of the task.</td>
</tr>
<tr>
<td>Start Time</td>
<td>The scheduled start time.</td>
</tr>
<tr>
<td>End Time</td>
<td>The scheduled end time.</td>
</tr>
<tr>
<td>% Completed</td>
<td>Completion</td>
</tr>
</tbody>
</table>
3.13.1.3 Configuration

Using the context menu, the view can be configured using the configure dialog. The configure dialog enables you to tailor the amount of information the view displays to fit your needs.

Configuration Dialog

3.14 Milestone Gantt View

3.14.1

3.14.1.1 Description

The Milestone Gantt view is used to show milestones in a time line.

Gantt View

3.14.1.2 Editing data

Milestone description and progress can be edited using the context menu. The following columns are displayed as default:

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>WBS Code</td>
<td>The Work Breakdown Structure code</td>
</tr>
<tr>
<td>Name</td>
<td>The name of the milestone.</td>
</tr>
<tr>
<td>Start Time</td>
<td>The scheduled start time.</td>
</tr>
</tbody>
</table>

3.14.1.3 Configuration

Using the context menu, the view can be configured using the configure dialog. The configure dialog enables you to tailor the amount of information the view displays to fit your needs.

Configuration Dialog
3.15 Resource Assignment Gantt View

3.15.1 Description

The Resource Assignment View displays the scheduled task-resource assignments in a table.

**NOTE**
This view can severely impact performance in large projects.

3.15.1.2 Data

The following columns are displayed as default:

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name of the object (Resource group, resource, task)</td>
</tr>
<tr>
<td>Total</td>
<td>The total assignment for a resource</td>
</tr>
<tr>
<td>Dates</td>
<td>The total assignments for a resource per day and the assignments for the resource per task.</td>
</tr>
</tbody>
</table>

3.15.1.3 Editing data

The task description and progress can be edited using the context menu.

3.15.1.4 Configuration

Using the context menu, the view can be configured using the configure dialog. The configure dialog enables you to include or exclude assignments.

<table>
<thead>
<tr>
<th>Configuration Dialog</th>
</tr>
</thead>
</table>

3.16 Resource Assignment View

3.16.1 Description

The Resource Assignment Gantt View displays the scheduled task-resource assignments in a Gantt chart.
3.16.1.2 Data

The following columns are displayed as default:

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name of the object (Resource group, resource, task)</td>
</tr>
<tr>
<td>Type</td>
<td>Object type</td>
</tr>
<tr>
<td>Start Time</td>
<td>The start of the assignment</td>
</tr>
<tr>
<td>End Time</td>
<td>The end of the assignment</td>
</tr>
</tbody>
</table>

3.16.1.3 Editing data

The task description and progress can be edited using the context menu.

3.16.1.4 Configuration

Using the context menu, the view can be configured using the configure dialog. The configure dialog enables you to select which columns to display.

<table>
<thead>
<tr>
<th>Configuration Dialog</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configuration Dialog</td>
</tr>
</tbody>
</table>
Chapter 4

Reports

4.1 Reports Generator View

4.1.1

4.1.1.1 Description

The Reports Generator View is used to add and generate reports in Open Document Text (odt) format.
The reports can be based on the supplied report templates, or you can write your own templates.

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>A name of your choice</td>
</tr>
<tr>
<td>Report Template</td>
<td>Path to the report template file. You can select one of the supplied standard templates or you can enter the filename of a template you provide yourself.</td>
</tr>
<tr>
<td>Report File</td>
<td>The name of the file that will be generated.</td>
</tr>
<tr>
<td>Add</td>
<td>Information that can be added to the report file name to distinguish it from previously generated versions. This can be: • Nothing; use the filename as is • Number; add a sequence number to the file name • Date; add the current date to the file name</td>
</tr>
</tbody>
</table>

4.1.1.2 Toolbar

The toolbar provides the means to add, remove and generate reports.
The Plan Handbook

<table>
<thead>
<tr>
<th>Button</th>
<th>Shortcut</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add Report</td>
<td>Ctrl-I</td>
<td>Add a new report</td>
</tr>
<tr>
<td>Remove Report</td>
<td>Ctrl-D</td>
<td>Remove the selected report</td>
</tr>
<tr>
<td>Generate Report</td>
<td>Ctrl-G</td>
<td>Generate the selected report</td>
</tr>
</tbody>
</table>

44
Chapter 5

Credits and License

Documentation Copyright see the UserBase Plan page history
This documentation is licensed under the terms of the GNU Free Documentation License.